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INTRODUCTION TO GEODICT 

GeoDict® is the innovative, integrated, and user-friendly material simulator and 
predictor developed by Math2Market®. GeoDict is the software for multi-scale 3D 

image processing, material characterization and analysis, material modeling, 
visualization, and property analysis.  

GeoDict is the tool needed for non-destructive material characterization, for the 
reduction of high-cost and time-consuming laboratory analysis, and for innovative, 
fast, and competitive material engineering.  

GeoDict allows you to: 

◼ Import and segment 3D- image data from micro-CT scans, nano-CT scans, or 

FIB/SEM-scans and  

◼ Convert this imported 3D-image data into 3D material models. 

◼ Characterize and analyze 3D morphological and physical material properties of 
these structure models by simulation. The Dict modules provide computational 
results of characteristics of pore space and solid materials, and physical properties 

such as flow velocity, permeability, effective elastic coefficients, and more. 
Effective flow properties and effective mechanic properties can be simulated for 

any 3D digital object. Advanced computations, for combined complex physical 
properties such as saturation-dependent material properties, or pore size 
distribution analysis are also available.  

◼ Output and export data for input into CAE tools and other software packages. 
Export to Fluent™ and Abaqus are available without further need for mesh 

generation beyond the previous export to standard 3D image formats, surface 

triangulations, and ASCII formats. 

◼ Design novel materials on the computer. The Geo modules, or structure 

generation modules, include nonwoven fibrous structures, paper and foams, 
woven structures, granular and sintered structures, pleats, and various regular 
structures with arrays of objects. Characteristic to all random structures is that 

they are defined through some average properties. This means that any time you 
generate one, a different structure appears. 

Structure manipulation includes virtual compression, morphological operations, 
simple image filtering, and construction of overlapping and layered structures, 

and many more. 

◼ Visualize 3D material models and property characterization results 

◼ Analyze and plot property characterization results 

◼ Script command sequences in Python to automate time-consuming, routine 
parameter studies or use editable pre-defined scripts (GeoApps) to quickly 

obtain results fitting a common process.

http://www.geodict.com/image.php?lang=en
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GEODICT APPLICATION IN INDUSTRY SECTORS 

GeoDict is used worldwide for simulation-driven material development, property 
characterization, and process optimization in many industrial sectors. Among others: 

◼ Filtration - Design of filter media and filter components, and optimization of 
filtration and separation processes for the automotive industry (catalytic 

converters), and design of membranes for industrial and environmental 
ultrafiltration (water, air). 

◼ Oil & Gas (Upstream) - Digital Rock Physics, Digital Sand Control, and Digital 
Hydraulic Fracturing for Enhanced Oil Recovery (EOR) in the upstream oil and gas 
industry sector. 

◼ Electrochemical storage and alternative power sources - Simulation of processes 
and design of components of fuel cells and batteries for the automotive industry. 

◼ Composites, ceramics, metals and foams – Design of materials and non-
destructive testing of properties (mechanical, thermal, electrical, flow) and 
simulation of processes for the automotive, aerospace, and alternative energy 

(wind) industries. 

◼ Hygiene – Design of woven and non-woven media for personal care and health 
industries. 

◼ Weaves & Paper - Simulation of processes and design of paper dewatering felts 
and forming fabrics for the paper industry. 

◼ Biomedicine, Biotechnology, Bioengineering – Studies of structural properties of 
porosity and diffusivity in scaffolds for regenerative implants, study of assemblies 

of supramolecular synthons, study of diffusivity in fungal pellets for production and 
extraction of proteins, organic acids and natural products, etc.  

◼ Thermal and electrical insulation - Design of thermal and electrical insulation 
media and simulation of thermal and electrical processes for construction and 
textile industries. 

◼ Acoustic insulation – Design of acoustic insulation media and simulation of 
processes for sound insulation.  

◼ Simulations for colloid transport and bio-geochemical interfaces for water 
remediation. 

◼ Simulations of flow for the delivery of pain alleviation medication through pump 
infusion systems. 

◼ Simulations of micro particle filtration and clogging phenomena in microfluidic 
devices. 
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GEODICT MODULES 

The GeoDict software suite is organized into modules which can be combined to suit 
the needs of specific applications in numerous industrial sectors. 

 

GEODICT BASE (WITH PRE- AND POST-PROCESSORS) 

◼ Structured, clear, and user-friendly Graphical User Interface, ray caster-render-

engine for fast and advanced 2D / 3D visualization, electron microscope view 
(SEM), and result viewer. Image and video capturing and processing tools for 
professional editing of images and the creation of sophisticated videos from 

material models and simulation results. 

◼ ImportGeo-Base imports GeoDict formats (GeoDict analytic data (.gad), GeoDict 

binary data (.gdt), GeoDict ASCII (.leS) and GeoDict 32 bit data (.g32). 

◼ ExportGeo-Base exports GeoDict material models and 3D-image data as volume 
image (.raw, .vol) and GeoDict analytic data (.gad), as well as Avizo binary files 

(.am) and 2D image stacks (as .png files). 

◼ GadGeo is the module to manually construct and manipulate analytic object 

material models for easy and interactive fine-tuning by object for adjustment of 
material models in 3D. 

◼ ProcessGeo modifies and transforms 3D structure models: cleanse, rescale, dilate, 

add binder, compress, reassign, etc. 

◼ LayerGeo layers and combines 3D structure models. 

◼ GeoLab is the GeoDict interface to Matlab® to automate processes and for 
seamless integration into current user workflows. 

◼ GeoPython is the automation interface integrated in GeoDict and based on Python 
3.6. With GeoPython, commands and functions can be recorded, edited, and 
executed as scripts prescribing sequences of operations without intermediate user 

interaction (macro) and with automatic parameter variation. 

◼ GeoDexcel for the analysis of GeoDict result data in a customized Microsoft Excel® 

spreadsheet.  

 

GEODICT MODULES FOR DIGITAL MATERIAL DESIGN 

◼ FiberGeo generates digital nonwoven and fiber reinforced composite models when 
given the statistical properties. This can be used to design materials with the same 

geometric properties as 3D material models from imported image data from µCT, 
nCT, or FIB/SEM, and study the influence of single parameters during the 
development and the calibration stages.  

◼ PaperGeo is the generalization of FiberGeo for cellulose natural fibers and 
generates digital paper models. In addition to the usual parameters specified for 

fibers in FiberGeo, the fibers may change diameter and have torsion.  

◼ GrainGeo generates digital granular and sintered ceramic material models, 
randomly close sphere-packed and piled structure models, and dense packs and 

piles of objects with arbitrary shapes. The generated model reproduces the 
randomness of the real structure and not its exact geometry. Advantages of using 
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GrainGeo generated models include the available high-resolution display, their 

periodicity, and the generation of countless structure variations.  

◼ FoamGeo models regular Kelvin structures (closed-cell foams, open-cell foams) 

and random foams. 

◼ WeaveGeo generates digital woven models based on thread distances, thread 

diameter, number of filaments, and weave pattern. 

◼ GridGeo models membrane layers as grids of spheres, cylinders, or foils with 
conical holes. 

◼ PleatGeo is the module to generate pleated filter models. 

◼ MeshGeo is the module to create triangulated models from GeoDict models and 

directly from gray values of CT-scans. It offers helpful functions for post-
processing the triangulations and making them ready for workflows with CAE 
software. MeshGeo is delivered within ExportGeo-CAD. 

 

GEODICT MODULES FOR DIGITAL MATERIAL ANALYSIS AND PROPERTY 

PREDICTION 

In 3D models generated in GeoDict and in 3D material models from imported 3D 

image data from µCT, nCT, or FIB/SEM, 

◼ FiberFind identifies fibers and binder quantitatively using trained neural networks 

(FiberFind-AI and BinderFind-AI) and determines the length, the diameter, the 
orientation, and the curvature of fibers in fibrous media. FiberFind works directly 
on 3D scans obtained through µCT or FIB/SEM. 

◼ GrainFind identifies grains and pores quantitatively with advanced algorithms and 
determines grain volume, diameter distribution and sphericity. It identifies binder 

in structures using trained neural networks (GrainFind-AI). GrainFind works 
directly on 3D scans obtained through µCT or FIB/SEM. 

◼ PoroDict determines pore structure characteristics such as geometrical pore size 

distribution, porosimetry and percolation paths, and estimates porous structure’s 
surface area, open and closed porosity, and the chord length distribution for the 

study of the properties of porous media.  

◼ MatDict is, with PoroDict, the module to characterize porous media. MatDict 

analyzes the geometry of the material components of porous media. It provides 
the structure’s material information, such as connected components, 1D- and 2D-
statistics (for density distribution), and GAD-Objects orientation (for realized 

anisotropy).  

◼ DiffuDict calculates effective diffusivity and tortuosity factor in porous media. 

◼ ConductoDict computes the effective thermal and electrical conductivity, 
respectively, in porous media and composite materials.  

◼ FlowDict simulates fluid flow (air, gas, water, oil, etc.), and calculates hydraulic 

properties such as pressure drop/velocity curves, flow velocity, flow resistivity, 
and flow permeability.  

◼ ElastoDict computes effective mechanical properties (Young’s modulus and full 
elasticity tensor), compression, and large deformations for porous and composite 
materials.  
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◼ FilterDict simulates filtration processes on various length scales. On filter media 

structure models, it computes pressure drop, MPPS, filter efficiency and filter 
lifetime. On 3D models of filter elements or complete filters including the filter 

housing, it determines flow patterns, pressure drop and filter lifetime. FilterDict 
visualizes particle motion and deposition, filter media clogging and cake 

formation. 

◼ BatteryDict is the module to design and analyze battery structures and to simulate 
the charging, discharging and cycling of Li-ion batteries.  

◼ AddiDict simulates the transport of solid particles in liquid-flow or gas-flow 
through porous materials. It provides effective diffusivities, breakthrough-curves, 

time-dependent particle concentrations as well as residence times of the particles 
in the different materials and the possibility to compute first order chemical 
reactions. 

◼ SatuDict calculates saturation dependent material parameters such as capillary 
pressure curves, two-phase flow, relative permeability, relative diffusivity, and 

relative thermal and electrical conductivity.  

◼ AcoustoDict computes the effective acoustic parameters needed for the Delaney 
Bazley and the Allard Johnson models, which calculate the acoustic properties of 

materials. 

 

GEODICT INTERFACES TO OTHER SOFTWARE 

◼ With ImportGeo-Vol and ImportGeo-CAD, GeoDict can import data from µCT- and 
nanoCT-scans or FIB/SEM image data of different 3D image file formats, and CAD 

file formats such as STL files.  

ImportGeo converts these formats into 3D-material models for material analysis 
or property analysis with other modules of GeoDict or external software packages. 

◼ With ExportGeo-Base, ExportGeo-CAD, ExportGeo-Fluent, and ExportGeo-
Abaqus, GeoDict can export 3D-material models as voxelized data, analytic data, 

RAW, VOL, Avizo binary files (AM), or PNG files, and as CAD formats (STL, WRL, 
OBJ, X_T, IGS, STP, SAT), and enables computations with Fluent™ and Abaqus 

on structures generated with GeoDict. 
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DOCUMENTATION AND SUPPORT 

This GeoDict Base Reference and the handbooks of the modules are aimed to 
familiarize you with the GeoDict software and to assist in using it efficiently.  

The Base Reference: 

◼ gets you started with GeoDict and explains GeoDict’s terminology 

◼ provides information on file management, conventions in GeoDict and 
morphological operations,  

◼ describes GeoDict’s GUI layout and briefly depicts GeoDict’s basic functionality. 

 

The handbooks for every GeoDict module are designed to clarify the functionality of 

the module by describing their GUI screen layouts and performing specific simulation 
tasks on sample applications. 

 

 

 

• Complete and up-to-date on-line documentation is available at 
www.geodict.com/Support/UserGuide.php 

• Tutorials with step-by-step instructions to complete a task with 
GeoDict are available at www.geodict.com/Support/tutorials.php 

• Workshop Videos and Video Tutorials for different applications are 
very useful to get started with simulations in GeoDict. They are 

available at www.geodict.com/Support/Workshops-
TutorialVideos/workshop-tutorialvideos.php or can be found directly 

in the Math2Market YouTube channel. 

• Math2Market GmbH offers specific training courses and online 
seminars for GeoDict. Information on current online seminars is 
accessible at 

www.geodict.com/Events/seminars_and_workshops.php 

• Have a look at the GeoDict forum (forum.math2market.de) to find 
answers to specific questions or to post a question yourself.  

• Additional personal assistance is reachable by contacting 
support(at)math2market.de.  

•  

http://www.geodict.com/
http://www.geodict.com/Support/tutorials.php
http://www.geodict.com/Support/Workshops-TutorialVideos/workshop-tutorialvideos.php
http://www.geodict.com/Support/Workshops-TutorialVideos/workshop-tutorialvideos.php
https://www.youtube.com/channel/UCRTnH7zN67h92iTHQaHQcow
https://www.geodict.com/Events/seminars_and_workshops.php
https://forum.math2market.de/
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FILE MANAGEMENT 

 

INSTALLATION, SETTINGS, AND PROJECT FOLDER 

GeoDict works with three different folders for the management of installation settings, 
user settings, and user result files: 

◼ The installation folder is the folder where GeoDict and the solver executables 

of the downloaded version are located. Among others, it also contains site-
specific default settings. 

 

 

◼ The settings folder is created during the process of licensing and installation. 

The settings folder contains user-specific default settings, the license file, log 
files, etc. It is located at ~/.geodict2022 in Linux and at 

 

in Windows. 

◼ The project folder contains the files with user-defined options and parameters 

for the generated structures and the result files from the solvers’ computations 
after working with GeoDict. It might be created and placed by the user at his/her 

convenience or, by default, is located at 

 

 

 



GeoDict 2022 Base Reference 

8  GeoDict2022 User Guide 

GEODICT FILE FORMATS AND EXTENSIONS 

The file extensions for the most important GeoDict files are as follows: 

 

GUF  GeoDict universal file 

 

Contains ASCII header followed by binary 

data. GUF is designed to contain all 
information on 3D images in a single file.  
Instances are saved by their own suffix and 

not found as .guf, e.g., .vap (velocity and 
pressure file), .das (displacement and 

stresses file), .gof (GeoDict orientation file, 
object orientation and position), .grw 

(GeoDict raw file, for gray-value images), 
.gpt (GeoDict particle trajectory), or .gpp 
(GeoDict particle position) 

.gad  GeoDict analytic data File format to store material models with 

analytic data. Save through File → Save 

Structure as… in the menu bar. See the 

GadGeo2022 handbook of the User Guide.  

.gdr  GeoDict result file Created during structure generation and the 
run of the solvers by all property predictors. 
Contains generation statistics and all solver 

results. 

.gdt  GeoDict compressed file Preferred file format to store and load 
structures in GeoDict. Save through File → 

Save Structure as… in the menu bar. 
Since GeoDict 2019, analytic data can be 
stored in .gdt files as well and not only 

voxel data. 

.py 

.gmc 
 GeoPython file 

GeoDict macro file 

(deprecated) 

Stores all parameters and settings recorded 
during GeoDict processes. Record a .py 

macro through Macro → Start Macro 

Recording… in the menu bar 

.gps   GeoDict project settings 
file 

Store the entries set in an option or 
parameter Edit dialog in the GUI by clicking 

the saving icon at the bottom of the 
corresponding dialog. 

https://www.geodict.com/Support/UserGuide.php?lang=en
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IMPORTED, EXPORTED, AND SAVED FORMATS IN GEODICT 

    Save formats with GeoDict 

.gdt .gad .leS 3D voxelized or analytic 

objects generated with 
GeoDict 

File → Save Structure as… 
.raw   

.png .xbm .bmp 

Image formats saved by 

GeoDict 
File → Save Image as… .jpg .pgm .pbm 

.xpm .ppm  

.mp4 .mpg .mkv 

File formats to save 

movies of models and 
results in GeoDict 

File → Save Video as… 

.vap .gvf .das 

File formats for 
visualization of structure 

models and simulation 
results. 

Saved by GeoDict solvers 

.pas .hht .dst 

.gof .gpp .leS 

.cap .g32 .gpt 

.est .raw  

.pde .cff .log 

File formats for 

parameter input to 
solvers and generators 

Saved by GeoDict solvers 

 

 

  Import into GeoDict 

using 

.gdt 

.gad 
.leS 
.g32 

ImportGeo-Base 

.raw 

.vol 

.grw 

.gdt  

.leS 

.g32 

.rek  

.am 

.txm 

.vox 

.iass   

.tif  

.bmp 

.cur 

.gif 

.ico 

.jpeg 

.jpg 

.pbm 

.pgm 

.png 

.ppm 

.svg 

.svgz 

.xbm 

.xpm  

ImportGeo-Vol 

.stl .obj ImportGeo-CAD 

 

 

 

 

 

 

 

 

 

 

  Export from GeoDict 

using 

.gad 

.raw 

.am 

.vol 

.png 
ExportGeo-Base 

.stl 

.wrl 

.x_t 

.obj 

.igs 

.stp 

.sat 

ExportGeo-CAD 

.msh .neu ExportGeo-Fluent 

.inp  ExportGeo-Abaqus 
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GEODICT SAMPLE STRUCTURES 

Sample structures can be downloaded in .gdt or .png file format.  

Some of them are too large to perform flow or strength calculations for them on single 
processor machines. GeoDict on multi core 64-bit computers brings this capability to 

desktop PCs.  

Sample structures may be found in the gallery of GeoDict Structures on the 

Math2Market website. 

 

http://www.geodict.com/Showroom/structures.php?lang=en
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GEODICT GRAPHICAL USER INTERFACE 

The standard GeoDict GUI (Graphical User Interface) is partitioned into Menu bar, 
Toolbar, Project Status section, Module section, Visualization area and 

Visualization panel, GUI Sidebar, Recent Files and Folders section, and 
Console. 

At the program start, the heading for the Module section is for one of the licensed 
modules, e.g., the FiberGeo module. The Visualization area shows the program’s 
splash screen. 

 

 

 

 

 

 

 

Visualization area and Visualization panel 

Toolbar 

Module section 

Console 

Menu bar 

Recent Files and Folders section 

GUI Sidebar 

Project Status section 
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When a structure model is displayed, a Visualization panel with several tabs 

appears above the Visualization area to control the visualization of the structure or 
the results computed for it. 

 

 

 

 

 

 

 

 

 

 

 

Visualization area 

Visualization panel 
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TOOLBAR 

The Toolbar displays tools for selected functions, mostly included in the Menu bar, 
frequently used in GeoDict. Resting the mouse pointer over a tool for a moment 
prompts a tool tip explaining the function. 

 

The selecting and editing functionality of Voxel Selection, GAD Object Selection, Paint 

and Metrology are part of the GUI Sidebar, and thus, are explained below starting on 
page 61.  
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MENU BAR 

The Menu bar contains the menus: File, Import, Model, Analyze, Predict, Export, 
View, Settings, Macro, GeoApp, and Help. Their functions are accessible by 
scrolling down in the pull-down menus.  

 

 

FILE 

The File menu entries are organized into 

panels: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

OPEN FILES, PACK AND LOAD RESULTS, PROJECT FOLDER 

Select Open Structure (*.gdt, *.gad) … 

to open a saved generated structure file in 
GDT format (GeoDict compressed format) 

or in GAD format (GeoDict analytic data). 
Such files are usually saved and, thus, 
located in a personal project folder created 

by the user for the current project. 

Select Open recent file… to choose a file 

from a list with the files opened or created 
in the last GeoDict session. 

Select Open Results (*.gdr) … to open and load result files in GDR format (GeoDict 

results), obtained from a previous run of a GeoDict solver or structure generator, and 
saved in the project folder.  

The toolbar icons  and  are the shortcuts to open structures and results. 
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Clean-Up / Pack Results (*.gdr) … 

allows to choose a result file and its result 
folder and to decide how the files that it 

contains should be handled. 

The user can decide if a particular File Type 

in the results folder should be kept or 
deleted. The results folder with the kept files 
can be packed. The original files can be kept 

or deleted after packing (Delete Original 
Results Folder after Packing)  

 

 

 

 

 

 

 

 

 

 

 

Select Load Volume Field… to open and visualize 
volume fields, e.g., .vap files (velocity and pressure) 
located in the result folders. The user can open and 

load result files for visualization in numerous formats. 

If a compressed volume field is opened, it is possible 

to load the field in compressed form or to decompress 
it during loading. A compressed field is saved when 
checking Write Compressed Volume Fields under 

the Solver tab of the LIR Solver Options dialog. 
Notice, that some operations and visualization 

features of volume fields are available only if the field 
is loaded in uncompressed form. 
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Select Load Particles... to open and visualize particle trajectories and particle 

positions for FilterDict or AddiDict simulations (.gpt and .gpp files). 

 

In Choose Project Folder…, click Select Project Folder… to open the Choose 
Project Folder dialog. Find the path to a previously created and already listed project 

folder (see also page 7), or right-click in the dialog to create a new project folder to 
save the results and settings files produced with GeoDict. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Follow Choose Project Folder… → Options… to set up how the project folder is 

selected at the start of GeoDict. Last project folder, or a Fixed project folder can 

be selected. 

The project folder will contain the files with the generated structures and the result 

files from the solvers’ computations.  

The location of the project folder is defined by the user at his/her convenience. The 
initial project folder for the first start of GeoDict, is located in Windows, by default 

at...  
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SAVE STRUCTURE, IMAGE, VIDEO, TRIANGULATION, OR VOLUME FIELD 

Select Save Structure as … to save the generated structure in the supported file 
formats (GDT, GAD, leS, and RAW).  

 

 

 

 

 

The file containing the structure data should be saved in the project folder.  

The toolbar icon  is the shortcut to this function. 

 

Choosing Save Image as … saves the current image in the supported file formats 
(*.png, *.jpg, *.xpm, *.xbm, *.bmp, *.pgm, *.ppm, and *.pbm) in the project 

folder. The toolbar  icon is the shortcut to this function. 
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For 2D images, in the Save Image dialog that opens, select first where to place the 

legend in the image. 

 

 

◼ Choose Attached to place the legend outside of the image but attached to it. 

 

 

 

 

 

 

 

 

 

 

 

If this is selected, the resolution can be selected automatically or manually by 
defining a zoom factor. Uncheck the Automatic Resolution box, to set the 

zoom factor.  

◼ Choose Overlay as the Legend Placement to allow that the legend overlaps 

the image. 
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In this case, the user can choose to save the image with the Current 

Resolution, to define a Custom Resolution or to use the Preset resolution 
values that fit his/her needs. 

A preview of the image is shown in the right part of the dialog. Click OK to select the 
settings. 

Choose a file name and an image format and save the image by clicking Save. 

 

 

 

 

 

 

 

 

 

For 3D images, choose the resolution to save the image with the Current 
Resolution, to define a Custom Resolution or to use a Preset resolution. 
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Select Crop all empty space to reduce the image size by removing all borders in 

background color.  

If this is selected, the image can be embedded in borders with the background color 

(Embed after cropping). The number of pixels for each border can be defined 
separately in this case.  

Finally, check Save with transparent background to save the image without a 
background color. 

 

Selecting Save Video As… allows choosing preset scripts that execute the making of 
a video with appropriate standard settings. The preset video scripts can be opened in 

the 2D or 3D Video Editor (Open Video Editor) for modifications. Minor changes, 
such as the description of the video or the number of frames per second (FPS) can be 
made through a dialog (Edit Video Preset). The following preset movie clips are 

available:  

◼ In 3D: Clipping X, Clipping Y, Clipping Z, Fly-by, Follow Particle, Particle 

Animation, Rotate X, Rotate Y, Rotate Z, and Streamlets. Also given is 
the option to import settings from the Video Dialog 3D to be listed in the preset 
video scripts (Import as Predefined Video), to produce a 3D video using 2D 

images from a stack of scanned images (Create Video from Image Stack), 
and to simply open the Video Dialog 3D editor without loading a specific preset 

video script (Open Editor). 

◼ In 2D: Back To Front (all slices), Back To Front, Front To Back (all 
slices), Front To Back, Import as Predefined Video, Create Video from 

Image Stack, and Open Editor. 

See the Create Videos 2022 handbook for more details about creating videos in 

GeoDict. 

 

 

 

The use of Save Image as... and Save Video As… are excellent and easy-to-

use choices when the user intends to present to the public structures and 
visualized results after working with GeoDict. 

The high resolution achievable when saving images or videos this way is suitable 

for press-ready flyers and posters. 

https://www.geodict.com/Support/UserGuide.php?lang=en
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Select Save Triangulation as… to save triangulations obtained by creating a mesh 

through MeshGeo or by importing in ImportGeo-CAD. 

Select Save Volume Field as… to save simulation results in several file formats. For 

example, after running a flow simulation with FlowDict, select a name to save the 
field of the velocity in X direction as raw float data (*.vol) or GeoDict universal file 

(*.guf). 

 

 

 

 

 

 

 

 

 

 

 

 

DISCARD STRUCTURE OR SIMULATION RESULTS 

Selecting Discard Structure and Fields makes the structure, and all simulation 

result fields available for this structure, disappear from memory and from the 
Visualization area. The initial GeoDict splash screen appears in the Visualization area 
instead. 

In the example shown here, a fiber structure is loaded in GeoDict, together with the 
volume fields of velocities in x-, y- and z-direction, loaded from the .vap file of a flow 

simulation.  

Clicking Discard Structure and Fields removes 
the structure, and the simulation result fields 

(volume fields) from the memory. 
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Selecting Discard Volume Field eliminates only the simulation result fields (volume 

fields) of the structure displayed in the Visualization area from memory. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In the same way, for a particle simulation result (created with FilterDict or AddiDict), 
if particle trajectories or positions are available in GeoDict memory, Discard 
Particles removes the particle information from memory. 

A structure in STL format (Stereosurface triangulation language), imported with 
ImportGeo-CAD, and shown in the Visualization area, is deleted from memory when 

Discard Triangulation is selected.  

CLEAR RECENT FILES / FOLDERS 

Clicking Clear Recent Files / Folders clears the list of Recent Files and Recent 

Project Folders shown in the GUI. 

MANAGE FLOATING LICENSE, CHOOSE LICENSE FILE, AND QUIT 

Clicking Manage Floating License… allows a floating license user to choose which 
of the licensed modules he would like to use in this session. Deselected modules will 
be shown as unlicensed in GeoDict’s menu, and their license will then be free for other 

users to use. 

Select Choose License File …. to select a license file, e.g., to change the license 

from evaluation to purchased or leased license, to upgrade the license for another 
term, or to request a new license file following the procedure explained in Licensing 
GeoDict in the Download, Installation and Licensing handbook of the User Guide. 

 

 

https://www.geodict.com/Support/UserGuide.php
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Selecting Quit ends the current GeoDict session. 
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IMPORT 

Accessible from the menu bar are interfaces to import image and structure files into 
GeoDict (ImportGeo). See page 5. 

For many image file formats, ImportGeo can perform 3D processing on gray value 
images and import them to the index image characteristic of GeoDict. The extraction 

from gray value images is done by segmentation, a procedure to convert them to 
index values. ImportGeo can also be used to load, import, and visualize a structure 
in the formats supported by GeoDict. 

ImportGeo-Base always appears in the menu because it is included in the GeoDict 
Base Package, other modules that have not been licensed appear under unlicensed 

in the list.  

Start an ImportGeo module by clicking Import in the menu bar and selecting one of 
the sub-modules available to import the file formats listed in page 9. If a module is 

selected, a dot appears in front of it in the module list and the module section changes 
to show this module. 

 

 

 

 

For complete information on interfaces to GeoDict see the ImportGeo-Base 2022 

handbook, ImportGeo-CAD 2022 handbook, and the ImportGeo-Vol 2022 handbook 
of the User Guide. 

 

MODEL 

The Model menu gives access to the list of modules for digital material modeling that 

are included in the user’s license.  

GadGeo, ProcessGeo, and LayerGeo can always be used because they are included in 

the GeoDict Base Package. Other modules that have not been licensed appear in the 
list under unlicensed.  

The GeoDict modules for digital material design available for licensing are: 

 

 

 

 

 

 

 

 

 

 

https://www.geodict.com/Support/UserGuide.php?lang=en
https://www.geodict.com/Support/UserGuide.php?lang=en
https://www.geodict.com/Support/UserGuide.php?lang=en
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ANALYZE 

The Analyze menu gives access to the list of modules for digital material analysis 
that are included in the user’s license.  

The GeoDict modules for digital material analysis available for licensing are: 

 

 

 

 

 

 

PREDICT 

The Predict menu gives access to the list of modules for the prediction of material 
properties that are included in the user’s license.  

GeoDict modules available for prediction of material properties are:  

 

 

 

 

 

 

 

 

 

 

EXPORT 

Accessible from the menu bar are interfaces to export structure files, images, and 
simulation results from GeoDict (ExportGeo) to many other software packages. See 

page 5. 

To export a GeoDict file to other formats, select Export in the menu bar, and choose 
between ExportGeo-Base, ExportGeo-CAD, ExportGeo-Fluent, ExportGeo-Abaqus and 

ExportGeo-MicroMacro.  
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With ExportGeo, structures from GeoDict can be exported to other formats so that 

files produced by the GeoDict user are compatible with other software and can be 
used for customized workflows:  

⚫ ExportGeo–Base converts voxelized data to RAW, VOL, PNG and Avizo Binary File 
(.am) formats. Furthermore, it converts analytic data, particles, trajectories and 

streamlines to GeoDict’s GAD format. 

⚫ ExportGeo-CAD converts voxelized or analytic structures to commonly used 
surface triangulation and CAD formats like STL, VRML, or Parasolid. 

⚫ ExportGeo-Fluent and ExportGeo-Abaqus convert voxelized data to formats for 
flow and heat computations with Fluent™ or elasticity computations with Abaqus. 

For complete information on interfaces from GeoDict, see the ExportGeo-CAD / 
MeshGeo 2022 handbook, the ExportGeo-Fluent 2022 handbook, and the ExportGeo-
Abaqus 2022 handbook of the User Guide. 

 

VIEW 

After modeling a structure, either by generating it in GeoDict or after importing 3D 
µCT or FIB/SEM images, choosing between the View menu entries changes the 
visualization settings. A shortcut to many of these parameters can also be set through 

the Visualization Side Bar, as explained shortly below, starting on page 60, and in 
more detail in the Visualization 2022 handbook. 

 

 

 

 

The View menu allows to: 

⚫ choose the visualization type to be 2D Cross 
Section (SEM), or 3D Rendering, with 3D 
Structure Renderer and the 3D View Ratio 

⚫ display the Visualization area in Full Screen 
which makes the Visualization area occupy the 

entire computer screen. Pressing the Esc key 
on the keyboard returns the program to the 

normal display. 

⚫ select which components are displayed in the visualization, and 

⚫ choose the Legends / Overlays to be displayed. 

 

Some of these options are only accessible when choosing to visualize in 3D 

Rendering or when visualizing solver results (Volume Field, Streamlines, 
Particles, Triangle Mesh, Schlieren, Arrows, and Tensors). 

Choose Detailed Settings to access the Visualization Side Bar, see page 60 and the 

Visualization 2022 handbook. 

https://www.geodict.com/Support/UserGuide.php?lang=en
https://www.geodict.com/Support/UserGuide.php?lang=en
https://www.geodict.com/Support/UserGuide.php?lang=en
https://www.geodict.com/Support/UserGuide.php?lang=en
https://www.geodict.com/Support/UserGuide.php?lang=en
https://www.geodict.com/Support/UserGuide.php?lang=en
https://www.geodict.com/Support/UserGuide.php?lang=en
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 Maximize the main screen to occupy the entire computer screen 

 

 Restore Down the main screen to the normal size.  
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SETTINGS 

The Settings menu includes Color & Visibility Settings, Settings, Edit Expert 
Settings, Edit Material Data Base, and Select Constituent Materials. 

 

 

 

 

 

 

The parameters entered in the Settings dialogs can be saved into GPS (*.gps, 

GeoDict Project Settings) files and/or loaded from them. Remember to restore and 
reset your (or GeoDict’s) default values through the icons at the bottom of the dialog 
when needed and/or before every GeoDict run.  

Resting the mouse pointer over the icons in the lower left of settings dialogs prompts 
a tool tip showing the icon’s function to appear. For example, for the Expert Settings: 

 

 

 

 

 

 

 

 

 

 

 

Clicking OK at the bottom of these dialogs, results in carrying out the modifications 
and closing the dialog. Select Cancel to discard the modifications entered in the 

dialog. Keeping a Color & Visibility Settings dialog open, instead of closing it by 
clicking Close, is helpful when trying to find the most adequate settings for a 

particular visualization.  

COLOR & VISIBILITY SETTINGS 

The default color settings applied to the background and materials during the 

generation with GeoDict, can be changed through the Color & Visibility Settings 
dialog, that opens on the right of the Visualization Area.  
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A color preset is a particular group of colors that are applied together. 

Click Load Preset and, in the Load 
Color Preset dialog, select whether 

to display the generated structure’s 
materials using one of the presets. 

 

 

 

 

 

 

 

 

After selecting new colors through the buttons in the Color & Visibility Settings 

dialog, the current group of colors can be saved as a preset (Save as new Preset), 
to have it appear in the list of color presets later. 

More details about the GeoDict colors and visibility settings can be found in the 

Visualization 2022 handbook. 

 

Gray values Material Database 

 
Reversed gray values 

https://www.geodict.com/Support/UserGuide.php?lang=en
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SETTINGS… 

Selecting Settings… from the Settings menu opens the Settings dialog to modify 
the general preferences or properties when working with GeoDict. The dialog contains 

the General, Parallelization and Statistics tabs.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

They contain a collection of settings that a user typically wants to apply to any GeoDict 

session. If the chosen setting should not apply only to this GeoDict session but should 
also be chosen at the next GeoDict startup, the user must, after making his choices, 
first click the icon at the bottom of the dialog: 

 

After setting the current settings as start-up setting, click OK.  

 

GENERAL 

The first option under the General tab controls the size of the fonts used in the GUI 
at start-up (GUI Start-Up Font Size). 

For example, increasing the GUI Start-Up Font Size to 14 results in the display of 
a larger font overall in the GUI after restarting GeoDict. 
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When Keep Copy of Last Structure is checked, 

 

GeoDict automatically stores a copy of the previous 3D structure, before applying any 

changes to it. This allows to quickly undo any changes using the undo function:  

 

Disadvantage of using Keep Copy of Last Structure is that some runtime and hard 

disk space is required for saving the structures. 

If Check for GeoDict Updates is checked, GeoDict will automatically search 
(requires internet connection) if updates are available and print a message if an 

update is found.  

 

GeoDict will not automatically download or install those updates.  

 

In the corresponding panels underneath are the options for disk usage (I/O), and for 
setting a default Text Editor. 
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I/O 

In the I/O (input/output) options, define how many days the log files, in which the 
events happening while running GeoDict are recorded, should be kept. 

Also define whether the time a warning message is displayed should be limited, and 
the time of the limitation in seconds.  

 

 

 

 

 

 

 

Text Editor 

The user can set which text editor is to be opened automatically when editing macros 
and other editable files. Click Browse to search and set the path to the location where 

the executable for the favorite text editor is located. 

 

 

 

 

 

 

PARALLELIZATION 

GeoDict Thread Parallelization 

The user can set the number of parallel processes (threads) GeoDict should use, e.g., 
for the visualization, for the image processing, and for the structure generation. When 

not all available CPUs of the computer should be used, perhaps to allow other users 
to work simultaneously on the same machine or to improve the running of other 

programs, the number of used parallel processes can be limited by setting a Manual 
Thread Number. 

 

 

 

 

 

 

Choosing Automatic Thread Number uses the maximum number, if up to eight 
cores are available. If more than 8 cores are available, the maximum of 8 and the 

number of cores divided by two is used. 
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This option has nothing to do with the solver processes, which can be set for all 

GeoDict solvers in the Dict modules independently. However, if the selected Number 
of Threads for a solver is larger than the number of threads that the license supports, 

an error message appears.  

Check Run external solvers with low priority to make the system more responsive 

when working interactively while a solver is running. 

Solver MPI Parallelization 

For cluster computations, set the environment variable that holds the location of the 
node file, i.e., the file that contains the list of assigned compute nodes. 

For MPI parallel computations, set the path to the MPI Installation that should be 

used for the parallelization. Select Automatic to look automatically for MPI 
installations. 

 

 

 

 

 

 

 

For more information, refer to the High Performance Computing handbook of the User 

Guide. 

STATISTICS 

The Connected Components panel is found under the Statistics tab. 
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A connected component is defined as a complete set of color voxels.  

Checking Show Number of Connected Components or Show Number of 
Connected Components in 2D Slice, and clicking OK, adds the number of 

Components 3D and Components 2D to the Statistics tab in the Visualization 
panel above the Visualization area. 

When Count Pore Space as Single Component is checked, the complete 
background is counted as one connected component. The pore space does not count 
as an object and does not add to the number of Objects. 

As example, a simple periodic structure model contains 10 spheres. At the corners, it 
is the same grey sphere that disappears and reappears on the other side. Two red 

spheres are also cut in half. They disappear and reappear in Z-direction. Three of the 
red spheres overlap and one of the red spheres touches a grey sphere. 

The number of Objects 3D is 10, but the number of Objects 2D is only 4 (2 grey 

and 2 red spheres) in the 2D-Slice 126 (move the slider under the Camera (Y,Z) tab). 
The pore space is not counted as object. 

 

Now, see how the connected components in 2D are counted when checking Show 
Number of Connected Components in 2D Slice. The number of Objects 3D and 
2D are the same as before. For Show Number of Connected Components in 2D 

Slice, the pore space and the red-grey touching spheres are each counted as a 
connected component. Connected components in 2D are 5 (1 grey sphere + 1 partial 

red sphere (top) + 1 partial red sphere (bottom) + 1 [1 red sphere+1 grey sphere] 
component + 1 pore space). 
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Next, Show number of Connected Components is checked and they are counted 

in 3D. Connected components in 3D are 13 (2 grey spheres + 4 partial grey spheres 
+ 1 red sphere + 4 partial red spheres + 1 [3 red spheres+1 grey sphere] component 

+ pore space). 

 

Periodicity, Neighborhood Mode, and Component Mode define criteria for the 

connectivity of the components. 

For periodic structures, checking Periodicity in X-Direction, Y-Direction, or Z-
Direction affects the number of connected components. Objects that end on one side 

of the volume and reappear on the opposite side are counted as being the same 
connected component, decreasing the final number of connected components.  

For example, the structure shown above is periodic in Z-direction, and without 
checking periodicity, 5 connected components in 2D are counted (#1 grey sphere + 
#2 partial red sphere (top) + #3 partial red sphere (bottom) + #4 [1 red sphere+1 

grey sphere] component + #5 pore). 
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Next, checking Periodicity in Z-Direction decreases the number of connected 

Components 2D to 4, because the red sphere at the edge of the domain reappears 
at the opposite edge and is then considered the same connected component.  

 

The 4 connected components are: (#1 grey sphere + #2 red sphere (top+bottom) + 
#3 [1 red sphere+1 grey sphere] component + #4 pore). The number of Objects 

does not change, and the same four objects are detected in 2D. The pore space is not 
counted in the number of Objects. 

 

Neighborhood Mode 

Neighboring structure components can be connected through faces, edges, and 
corners of voxels, i.e., two voxels of the same color that share a corner point always 
belong to the same connected component.  

Checking Face is more restrictive than choosing 

Face or Edge, and this more limiting than selecting 
Face, Edge or Corner.  
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Component Mode 

For structures with more than one material, selecting Pore/Solid from the 
Component Mode pull-down menu determines whether the components are 

considered connected or not, based on being empty voxels (background) or solid 
voxels (structure), regardless of their color. When selecting Material ID, the color of 
the solid voxels (structure) is determinant for the components to be considered 

connected or disconnected.  

 

Periodicity: un-checked for all directions 

Neighborhood mode: Face 

5 connected components 2D = #1, #2 (half sphere 
top), #3 (2 spheres touching), #4 (half sphere 
bottom), and #5 pore.  

 

 

 

 

 

 

 

 

 

Periodicity: un-checked for all directions 

Neighborhood mode: Face 

7 connected components 2D = #1 (grey sphere), #2 
(half red sphere top), #3 (red sphere), #4 (grey 
sphere), #5 (1 blue overlapping voxel), #6 (half red 

sphere bottom), and #7 pore. 
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EDIT EXPERT SETTINGS… 

For many commands available in GeoDict’s modules, additional parameters exist that 
are not available through the dialog widgets that open in the corresponding modules. 

These parameters are also not stored in the parameter lists of those commands inside 
the python macros. By default, no expert settings are set, and well-chosen default 
values are used.  

Some expert settings allow to access experimental or unstable features. Others allow 
to access solver variants that are only useful in very special circumstances. In general, 

a user should not set any expert settings without consultation of Math2Market.  

 

 

To activate an expert setting, after selecting Edit Expert Settings…, the user clicks 

Add Row to sequentially select the Module, the Command, and the Key that define 
the expert setting that should be edited.  
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The choices of module, command, and key are entered as columns into the first row. 

The user can now click the cell under Value and manually enter it. 
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SELECT CONSTITUENT MATERIALS 

A Constituent Material from the Material Database consists of a name for the raw 
material and the material’s physical properties and represents the properties of a 

material in a structure model. 

 

 

 

 

 

With a structure model in memory, showing 
in the Visualization area, select Settings → 

Select Constituent Materials to change the 
raw material of a Material ID or assign a 
material to a Material ID with undefined 

material in a structure model.  

For example, in a foam structure the Material 

ID 01, initially defined as Aluminum, can be 
changed to be made of Steel as follows: 
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If the new material is selected, close the dialog 
by clicking OK in the Material Selector dialog and 

Run in the Select Constituent Materials dialog. 
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EDIT MATERIAL DATA BASE… 

In GeoDict, constituent materials (and their physical properties) are globally 
assigned to a structure and not just to a property predictor simulation. 

The GeoDict Material Database is a catalogue of the constituent materials that can be 
assigned to correctly identify digital materials in the structure models with properties 
of real materials.  

The user can access and edit the GeoDict Material Database from many modules or 
select Settings → Edit Material Data Base… to directly access the catalogue from 

the menu bar. 

 

 

User-defined materials can be added to expand 
the GeoDict Material Database, or further 

properties can be listed for a material already 
included in the database. This is described in detail 
in the Material Database 2022 handbook of the 

User Guide. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Each material in the database, together with its properties and description, is saved 
as a text-file with the name of the material. The user can edit these files in any text 
editor. The default GeoDict Material Database is located at: 

 

 

 

https://www.geodict.com/Support/UserGuide.php?lang=en
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MACRO 

The Macro menu contains the entries Start Macro Recording, and End Macro 
Recording, Execute Macro/Script, and Session Macro.  

 

 

The entry End Macro Recording can be selected 
only during the recording of a macro to end the 

recording. 

 

 

Macro recording and execution and the options Convert GMC to Python Macro and 
Re-execute Last Python Script are explained in detail in the Automation 2022 

handbook of the User Guide. 

 

 

https://www.geodict.com/Support/UserGuide.php?lang=en
https://www.geodict.com/Support/UserGuide.php?lang=en
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GEOAPP 

When selecting GeoApp in the menu bar and selecting one of the entries in the pull-
down menu, the module section (left of the Visualization area) changes to enter 

parameters for the execution of pre-installed Python scripts for a variety of 
applications.  

 

 

The preinstalled Python scripts are: 

◼ 3D-Image Report 

◼ Compute Tortuosity 

◼ DegraDict 

◼ Digital Rock Physics (DRP) 

◼ Easy Image  

◼ KaleidoScript 

◼ Predefined macros for several modules. They can 

also be found in the pull-down menus of the module 
sections of these modules by selecting Predefined.  

 

 
 

Selecting a GeoApp from the list opens the GeoApp section, located left of the 
Visualization area. It contains a pull-down menu that lists the available Python scripts 
for the corresponding GeoApp. 

When selecting one of the available scripts, the description area displays a report 
about the script. In the script, this report content can be found inside the apostrophes 

after Description = ''' ''' and can be edited at any time after opening the script with 
a text editor.  

For the NMR (Spherical Pore) script from the Digital Rock Physics (DRP) App, 

the text in the macro and the description area are shown here. 
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Click the Options’ Edit … button to edit the parameters of the macro. To open the 

GeoApp in an editor, click Open Macro / Script File. Clicking Run executes the 
script. 

The GeoApp scripts listed in the pull-down menus can be found in the GeoDict 
installation folder in the subfolder GeoApp or in the subfolder of the corresponding 

module. 

More details about using GeoApps can be found in the GeoApp 2022 handbook of this 
User Guide. 

 

https://www.geodict.com/Support/UserGuide.php?lang=en
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HELP 

The Help menu links directly to several volumes of the User Guide on the GeoDict 
web page for information on installation and licensing of GeoDict, the introduction to 

the GUI and the Base Reference, the Result Viewer for the result files, Visualization 
and video creation in GeoDict, using GeoLab and GeoDexcel and setting up high 

performance computing. 

 

 

All User Guide handbooks can be downloaded as 

a block in zipped .pdf format. 

Clicking About GeoDict opens a window giving 
information on GeoDict version, revision 

number, and licensing.  

 

 

We also acknowledge the third-party 
components used in GeoDict. 
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PROJECT STATUS SECTION 

The project status section displays the current CPU load, the currently used RAM 
and the percentage of Disk Space used on the drive where the project folder is 
located. This refers to all processes running on the computer, not only to GeoDict.  

The project folder’s path is also shown.  

The Structure model is identified by File Name, Description, the Voxel Count, the 

Voxel Length, the Domain Size and the internally hashed Structure ID number. A 
structure generated, e.g., with FiberGeo, GrainGeo, PaperGeo, WeaveGeo, GridGeo, 
or PleatGeo, with the same parameters and the same random seed, has always the 

same Structure ID number. The Structure ID number changes as soon as the 
structure is modified in any way.  

The current Voxel Length is shown in the selected units (m, mm, µm, nm, Inch). 

Right-clicking on the Structure row opens a menu used as a shortcut to apply 
modifications to the microstructure. 

 

 

 

 

 

 

 

 

 

 

 

 

Most of the commands in this menu are shortcuts to several functions included under 
the File menu in the menu bar, in the ProcessGeo module (Model → ProcessGeo), or 

in the LayerGeo module (Model → LayerGeo). 
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Some of these modifications can be carried out directly from the Structure row.  

For example, the Description of the structure or even the Voxel Length, which can 
be adjusted directly by right-clicking on Voxel 

Length and changing parameters in the opening 
Adjust voxel length dialog.  

 

 

 

 

 

 

 

 

 

This change in voxel length occurs on the already generated structure (post-

processing). To vary voxel length for the generation of a new structure (pre-
processing), the value has to be changed through the Create → Options - Edit… 

button in the module section of the corresponding Geo module (FiberGeo, GrainGeo, 

WeaveGeo, etc.)  
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The color dot in front of Objects shows whether information about the objects inside 

of the current structure are available (green dot), or not (red dot). 

The dot is yellow when information about objects inside of the current structure is 

available, but this information does not describe the current structure completely. 
This may happen, for example, when the structure has been modified after the 

generation (e.g., with ProcessGeo or LayerGeo). 

Also shown in the Project Status section is the number of objects (such as fibers, 
grains, etc.) in the structure (GAD Object Number). 

Right-clicking on Objects opens a list of possible modifications, like editing the GAD 
objects or the domain, creating, adding, deleting, scaling, shifting and rotating GAD 

objects, resolve overlap and mark contacts, change the Material ID model, or to create 
a GAD index image or an orientation image. All of these modifications can be accessed 
also from the module GadGeo and are explained in the GadGeo 2022 handbook of the 

User Guide. 

 

By choosing Algorithms, all manipulations of analytic objects, available in the section 

Algorithms of GadGeo can be accessed. 

 

The next entry in the Project Status section is Constituent Materials. This block lists 
the materials that are present in the structure and are shown in the Material 
Information legend next to the microstructure in the Visualization area. 

 

In the example shown here, two Constituent Materials are listed in the Project 

Status section (Air and Manual), corresponding to Air and Solid in the Material 
Information legend. The fibers with material ID 01 and material ID 02 are set to be 
made of the same constituent material. 

 

 

 

https://www.geodict.com/Support/UserGuide.php?lang=en
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Right-clicking on Constituent Materials gives access to the Select Constituent 
Materials dialog and is a shortcut to selecting Settings → Select Constituent 

Materials in the menu bar and to the Change Temperature Dialog. 

 

After changing the constituent material for 

material ID 01 to Aluminum and material ID 02 
to Nickel, the number of Constituent 

Materials in the Project Status section 
changes from (2) to (3). 
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The last two entries in the Project Status section are Open Result Files and 

Volume Fields.  

Open Result Files shows the number and names of result files that are currently 

open in the Result Viewer. 

After loading a result file and a corresponding volume field (e.g., after an effective 

stiffness simulation with ElastoDict-FeelMath-VOX), the name of the result file (Open 
Result Files) and the corresponding Volume Fields appear in the Project Status 
section, and the loaded volume field can be shown in the Visualization area.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Right-clicking on the volume fields opens a list of options.  

Choose Properties to get information on the volume field loaded.  
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With Compute Metrics, access statistical properties of the volume field, like 

maximum or minimum value, mean, variance, etc. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Select Threshold to Structure to create a structure with voxels above or below a 

defined threshold of a volume field. In GeoDict 2022, one or two thresholds can be 
defined. 

For one threshold, check Preview Threshold in 3D to visualize the created structure 
already before clicking Run. 

Define e.g. 2 thresholds to create a structure with voxels of ID 01 where the von 

Mises Strain of the fibrous structure is above 1e-06, and with voxels of ID2 at 
locations with von Mises strain above 4e-06. 
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A volume field can be saved as .guf file, moved or copied to another volume field or 
removed from the GUI.  

Choose Math Operation to open a dialog that allows to manipulate the volume field 
in different ways.  

 

 

 

 

 

 

 

 

 

◼ Normalize Field: define a new minimum and maximum value and normalize 
the values of the volume field accordingly. 

◼ Subtract Field: choose another volume field, e.g., from another result file, that 
will be subtracted from the current volume field. 

 

 

 

 

 

 

 

 

◼ Add Field: choose another volume field that will be added to the current one. 
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◼ Compute Gradient: compute the gradient for the current volume field. 

◼ Convert to Data Type: choose a new data type (single, uInt32, uInt16 or 
uInt8) and convert all values of the current volume field to this type. 

◼ Add (Subtract) Constant Value: add or subtract a constant value from the 
volume field. 
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MODULE SECTION 

The heading of the Module section changes accordingly when selecting to work with 
the GeoDict modules for which the user has a license (see page 25). The GeoDict 
modules are organized into modules to Import and pre-process files and 3D image 

data, generator and structure-modifying modules to Model microstructures, structure 
analyzing modules to Analyze, properties predictor modules to Predict, and modules 

to Export files to other formats. 

 

 

 

 

 

 

The module section contains a Browse... or Edit… button to choose files or edit 

options necessary for GeoDict’s generators, modifiers, or solvers, and a Help button 
directly linking to the User Guide Reference for the module currently in use.  

 

 

 

 

 

 

 

 

The module section often includes a Record button, which is selectable when Macro 
→ Start Macro Recording... is selected in the menu bar. Clicking Record allows 

recording the settings and actions of the module without obtaining the results (yet), 
while Run & Record starts the computation and additionally records the action in the 
macro file. 

 

 

 

 

 

 

 

 

 

Depending on the module, the button Generate, Run, or Export starts the actions 

of the generator, the solver or the export. For ProcessGeo and LayerGeo, the button 
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specifies the particular modifying process (Reassign, Rescale, Compress, Attach, 

Erode, Dilate, etc.). 

For some modules, the module section includes an Estimate Memory or Estimate 

Memory & Disk-Space button, that becomes active for the functionalities that 
support such an estimation. It allows to estimate the memory (and disk-space) 

required for the computation before starting the computation. 

The use of the modules is explained in each of the module’s handbooks. 
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VISUALIZATION AREA AND VISUALIZATION PANEL 

Initially, the Visualization panel shows information about the image displayed in 
the Visualization area. The image might be of a fibrous-, paper-, granular-, 
sintered-, pleated-, woven-, or grid-structure created with one of GeoDict’s structure 

generators, an image from an opened *.gdt file, an image imported and segmented 
with ImportGeo-Vol or ImportGeo-CAD from a stack of 3D image data (µCT, 

FIB/SEM), or other structure models. 

The visualization of computational results changes the panel, by activating other tabs, 
to access options to visualize the results optimally. 

Complete information on visualization of structures and results in GeoDict, and all 
options, is available in the GeoDict Visualization 2022 handbook of the User Guide. 

In 2D Cross Section view, zoom 
in and out smoothly by keeping 
the right mouse button clicked 

and moving the mouse forward 
and backward. Or zoom stepwise 

by clicking the Zoom buttons on 
the Camera tab.  

 

In 3D Rendering, zoom by 
keeping the right button pressed 

and simultaneously moving the 
mouse forward. By moving the 
mouse backward, the image 

zooms out. Or zoom in and out 
by scrolling the mouse wheel. 

 

 

 

The visualization display and the 

data shown in the panel change if 
different parameters or settings 

are selected in the View menu 
and in the Settings → 

Settings… menu, see page 31. 

 

 

 

 

 

 

https://www.geodict.com/Support/UserGuide.php?lang=en
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Select to view the structure in 2D Cross Section (SEM) or 3D Rendering mode.  

In 3D Rendering, render the structure on the graphics card (GPU) or the main 
processor (Box with raycasting or Smooth with raycasting). Volume raycasting is an 

image-based volume rendering technique that computes 2D images from 3D 
volumetric data sets. 

Select Full Screen to make 
the Visualization area occupy 
the entire computer screen. 

Pressing the Esc key on the 
keyboard returns the program 

to the normal display. 

 

When un-checking Structure, 

the complete structure 
disappears from the display. In 

the same way loaded results, 
like Volume Fields, 
Streamlines, Particles, 

Triangle Mesh, Schlieren, 
Arrows and Tensors can be 

switched on and off in the 
visualization. 

 

 

To start the visualization of results, a result file must be loaded through File → Load 

Volume Field … or Load Particles … in the menu bar, or directly by loading from 
the Visualization tab of the GeoDict Result Viewer. 

 

Among the Legends / Overlays, unchecking Bounding Box makes the border 
surrounding the domain disappear in 3D Rendering. Unchecking Scale Bar or Axes 

make the scale bar and/or the coordinate stencil in the lower left corner disappear 
from the display while in 2D Cross Section (SEM) or in 3D Rendering. 

Unchecking Volume Field Legend and/or Material Legend hides the legends of a 

volume field or for the constituent materials present in the structure. 

The particle time, displayed for a particle simulation, the display of the GeoDict logo, 

the status information or the display of the status bar can be switched on and off as 
well. 

More detailed information about visualization in GeoDict can be found in the 

Visualization 2022 handbook of the User Guide.

http://en.wikipedia.org/wiki/Volume_rendering
https://www.geodict.com/Support/UserGuide.php
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GUI SIDEBAR 

Starting with GeoDict 2020, many of the options that were previously available only 
under the View menu in the menu bar, have moved for convenience of usage to the 
sidebar to the right of the GUI.  

In GeoDict 2022, dialogs for Visualization, Color & Visibility Settings, the editing 
and modifying functions (Voxel Selection, GAD Object Selection and Paint mode) 

and the measuring of distances and angles (Metrology) can now also be opened 
directly from the GUI sidebar. 

This sidebar now controls all visualization settings, editing, modifying, and measuring 

functionality centrally. It can be expanded and collapsed by clicking on the  icon on 
the tabs.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When expanded, the sidebar panel can be un-docked by clicking the  icon at the 
top of the open panel and, so, turned into a dialog that can move around. 
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Information about the Visualization tab and the Color & Visibility tab from the GUI 

sidebar can be found in detail in the Visualization 2022 handbook of the User Guide. 

The functionality of the tabs Voxel Selection, GAD Object Selection and Paint is 

explained below. 

WHAT ARE VOXELIZED AND ANALYTIC STRUCTURE MODELS? 

Objects in structure models in GeoDict can be described in: 

⚫ GAD format: An analytic description including the properties of gad-objects, like 

their diameter, position and material properties, written to an ASCII-file. 

⚫ GDT format: A 4-bit volume representation of the structure that contains the 
voxel geometry. The new GDT format, available since GeoDict 2019, can contain 

also the analytic description of the objects (if available when the structure is 
saved). 

Editing and modification of structure models can be done on the structure’s voxel 
geometry description or analytic description.  

Simple and complicated microstructures can be edited by manual drawing, e.g., to 

correct problematic boundary effects. Among other applications, voxel and analytic 
data editing can be used to remove artifacts from 3D structures built from imported 

3D-image data (micro-CT, nano-CT, SEM, …).  

For structure models created using GeoDict’s generator modules, undesired 

fragments of the structure can be easily modified or eliminated, without having to 
reset the parameters and generate again.  

This direct editing or modification of voxelized and analytic structure models is a 

complement to the GadGeo module. GadGeo generates and edits on the analytic level, 
on structures with available analytic information, whereas editing is also applicable to 

structure models with voxelized formats.  

Structure models can be manually edited with GeoDict, using the following icons in 
the toolbar: 

Part of the functionality for structure editing can be accessed also by a right mouse 
click in the visualization area, see page 70. 

Here, as a simple structure example, a fibrous media model is generated with 

FiberGeo and then the structure model is saved in GDT format and in GAD format. 
The structure model contains curved fibers of two different raw materials, initially set 

as Manual (Solid).  

Below follow examples to edit and modify this fibrous media model structure in both 
formats. 

GDT – 3D 
 

Edit the previously selected voxels. 

GAD – 3D 
 

Edit the previously selected analytic objects. 

GDT – 2D 
 

Edit in a way similar to the Windows standard editor Paint. 
Observe results in 3D (edited objects are three-dimensional) 

https://www.geodict.com/Support/UserGuide.php
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VOXEL SELECTION AND EDITING FOR GDT FORMAT 

With the new GDT format .gdt files can contain also analytic object information. If the 
fibrous material model in GDT format is loaded, the same information as for the same 

structure model having been saved in GAD format (see below) is shown in the project 
status section.  

 

 

 

 

 

 

 

 

 

 

We now want to edit the structure by editing the voxels. By changing the voxel 
structure, the analytic object information is not modified, and therefore the analytic 
object description in the model is lost. The initially green dot before Objects turns 

red, if one of the operations listed below is applied. 

The voxels forming a fiber in the structure model are edited in 2D Cross Section (SEM) 

view or in 3D Rendering, as follows: 

1. Select voxels:  

a. Zoom into the structure by pressing and holding the right mouse button while 
moving the mouse back and forth or scroll the mouse wheel. 

b. To enter the Voxel Selection mode, click the  icon in the GUI sidebar or the 

 icon in the toolbar. The Voxel Selection dialog opens.  

c. Click on the voxel(s) that should be edited. For several voxels, press and hold 
the Shift key on the keyboard while clicking the voxels. A cyan-colored frame 
appears at the edges of the selected voxel(s).  
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At the same time, the parameters defining the voxel(s) (Position as X, Y, Z and 

Material ID) appear in a table in the Voxel Selection dialog. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

d. If a voxel is mistakenly selected, click again on that voxel.  

e. Clicking Clear Selection in the Voxel Selection dialog removes all voxels from 

the selection. 

2. Edit voxels by selecting one of the Component Mode commands and clicking 
Run: 

a. Flood-Fill Component: fill the selected voxels and the components connected 

to them (see page 35) with a New Material ID chosen from the pull-down 
menu.  
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b. Flood-Fill Component Plane: fill the selected voxels and the components 

connected to them with a New Material ID only in the Plane chosen from the 
pull-down menu. 

 

c. Reassign Material of Objects (*.g32): If a *.g32 file with object indices is 
loaded in the GeoDict GUI (e.g., created by right clicking on Objects in the 
Project Status Section and selecting Create GAD Index Image, see page 50), 

the Object ID is additionally shown for each voxel selected. 
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Select a New Material ID and click Run, to assign the new material to all 

voxels that belong to the same Object ID as the voxels selected (here Object 
IDs 76, 104 and 163). 

 

 

 

 

 

 

 

 

 
 

d. Reassign Material of Selected Voxels: The material ID of the selected voxels 
can be changed by selecting a New Material ID from the pull-down menu. 
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e. Dilate Selected Voxels: It is possible to dilate the voxels by coating them 

with another material chosen from the Coating Material ID pull-down menu 
by a certain number of voxels (Dilate by) 

 

f. Dilate Component: Also possible is to dilate the selected voxels and the 

components connected to them with the Coating Material ID by a certain 
number of voxels (Dilate by) 
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g. Dilate Component Plane: Dilate the selected voxels and the components 

connected to them only in the Plane chosen from the pull-down menu with the 
Coating Material ID by a certain number of voxels (Dilate by) 

 

 

All these operations can be undone by clicking the  icon or CTRL+Z. 
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GAD OBJECT SELECTION AND EDITING FOR GAD FORMAT 

The same fibrous media model as in the section 
above is edited, but now the analytic objects are 

modified. This is possible if a structure in GAD 
format is loaded, or a structure in GDT file format 

with analytic object information contained in the 
GDT file. The information that appears in both 
cases in the Project Status, is equivalent.  

In contrast to editing the voxel structure, editing 
the analytic objects preserves the analytic object 

information in the file. 

 

 

The analytic objects (fibers) in this fibrous structure model can be edited, while 
visualizing the material model in 2D Cross Section (SEM) view or in 3D Rendering, as 

follows: 

 

 

 

 

 

 

 

 

1. Select analytic objects:  

a. To enter the GAD Object Selection mode, click the  icon in the GUI sidebar or 

the  icon in the toolbar. The GAD Object Selection dialog opens.  

b. The upper table shows the ID number and the Object Type of the selected 
fibers. 

c. Click on the fiber that should be edited. For several fibers, press and hold the 
Shift key on the keyboard while clicking the fibers. The selected fiber(s) 

appear(s) highlighted. 

d. If a fiber is mistakenly selected, press and hold the CTRL key and click on the 
fiber again. 

2. Edit analytic objects: 

a. When clicking Delete Objects, all selected fibers, which are listed in the upper 
table, are deleted and taken out from the structure model. 

 

b. Change Material ID: The material ID of the selected objects can be changed 
by selecting a new material ID from the pull-down menu and clicking Change 

Material ID. 
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The selected fiber(s) still appear(s) highlighted (and perhaps makes it difficult to see 
the change in the material) until the user clicks Clear Selection. 

Now the fibrous structure model contains fibers of three different materials. 
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SHORTCUT TO SELECTION AND EDITING FOR GDT AND GAD 

In GeoDict 2022, part of the selection and editing functionalities explained above can 
be accessed directly by a right mouse click in the structure shown in the Visualization 

area.  

In this way, voxels or GAD objects can be selected and are added to the Voxel 
Selection dialog or the GAD Object Selection dialog.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Previously selected GAD objects can be removed from the dialog (Deselect GAD 
Object), or the selections of both dialogs can be removed completely (Clear 
Selection). 

Choose Reassign Selected GAD Objects to assign a new material ID to the selected 
objects. 
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With Edit Selected GAD Objects, all objects listed in the GAD Object Selection 

dialog can be modified at once. Edit GAD Object allows to modify only the currently 
selected object, here object 54. 

Voxels listed in the Voxel Selection dialog or the whole components connected to 
them, can be reassigned to a new Material ID with Reassign Selected Voxels or 

Flood Fill Selected Voxel Components. Choose the new Material ID for the 
operation. 

 

By a click with the right mouse button on the structure, it is also possible to Edit the 
Domain and to access the ProcessGeo functionalities Crop and Embed. 

 

 

 

 

 

Select the options available under Controls, to Reset View settings according to the 
startup-settings (see the Camera tab on the Visualization panel), to switch between 
the icons of the toolbar for the mouse functionalities (Navigate, Edit Voxels and 

Edit GAD Objects), 

 

 

 

 

 

 

and to change the settings for the Tooltip shown for the structure. 

 

 

 

 

 

 

 

 

 

 

Choose, which information should be shown for the position of the mouse pointer in 

the structure. For the position of a voxel, the coordinates can be shown in number of 
voxels in each direction (Show Voxel Coordinates) or as coordinates with respect 
to the origin of the structure (Show World Coordinates).  
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Check Show Voxel Material to add the material information to the tooltip. Check 

Show GAD Information, to show the number and object type of the GAD object the 
voxel belongs to (only shown if analytic object data is available for the structure).  

Select Show Volume Field Information (Visible Only) or Show Volume Field 
information (all) to show the value of the currently selected volume field, or of all 

volume fields available, at the current position, if a volume field is loaded for the 
structure. 

 

 

 

 

 

 

 

 

 

 

Use Uncheck All to deselect all boxes of the Tooltip options, or Reset to Default 

Settings to reload the GeoDict default settings for the tooltips. 

 

 

 

 

Check Infinite Tooltip Duration to prevent the tooltip from vanishing after a few 
seconds. 
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PAINT 

The Paint Mode editing works in a way similar to the Windows standard editor Paint. 

Editing is always done in 2D (View → 2D Cross-Section (SEM)) and the effects can be 

seen later in 3D (View →3D Rendering). 

Paint Mode can be used for GDT files and for GAD files. However, using the paint 
mode on a GAD file or GDT file with analytic object information terminates the analytic 
data character. This can be observed in the green dot turning red in the Project 

Status section after applying the paint mode. 

A fibrous media model with analytic object information is edited with Paint Mode.  

 

 

 

 

 

 

 

The Paint mode is used as follows: 

1. Select View → 2D Cross-Section (SEM) in the menu bar or click the  icon in 

the toolbar.  

In the Visualization panel, above the Visualization area, click the Camera (Y, Z) 
tab and use the Direction pull-down menu and the Slice slider to navigate to the 

location where the editing should take place. Here is direction Z and slice 90 
selected. 
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2. Click the Paint tab on the GUI sidebar or the  icon in the toolbar to open the 

Paint Settings dialog The Paint tab is greyed out and not accessible when the 
structure is viewed in 3D rendering. 

3. In the opening Paint Settings dialog, editing is done using a brush and its size 
and shape are set in the Brush Shape pull-down menu and in the Brush Length 
(Diameter) X, Brush Length (Diameter) Y and Brush Length (Diameter) Z 
boxes.  

The brush length is given in voxels. 

The brush shape can be a Box, 

with the side lengths entered in 
Brush Length X, Y, and Z, or a 
Sphere (Ellipsoid) with the 

diameters entered in Brush 
Diameter X, Y, and Z.  

The Material ID of the material to 
edit is chosen from the Material 
ID pull-down menu.  

The choice of Brush Mode in the 
pull-down menu determines the 

working technique for the brush. 
With Set, the selected material 
replaces the original material. 

With Add and Subtract, 
material is added to or 

subtracted (removed) from the 
original material. With Replace, 

material of a selected ID is 
replaced by a new material. 

 

 

 

The Draw Mode defines whether the brush stroke is applied for Continuous 
Drawing, for a Single Click or for drawing a Straight Line. 

4. The brush strokes, in the selected shape, size, and Material ID (here Sphere, 
diameter 5 x 5 x 10 voxels, Material 03), are applied by pressing (for Continuous 

Drawing and Drawing Straight Lines) and by clicking (for Single Click 
Drawing) with the left mouse button in the desired position.  

Strokes at different spatial locations are applied by selecting a different Direction 

(X, Y, or Z) and/or a different Slice in the Visualization panel, above the 
Visualization area.  

For Draw Mode Continuous, press the left mouse button while dragging the 
mouse. Moving the mouse too fast results in an irregularly dashed line.  

The effects of editing (in 2D view) are observed as soon as the left mouse button 

is released. Here, voxels of material ID 00 have been replaced by voxels of Material 
ID 03, which are blue. After editing, close the Paint Settings dialog and switch to 

3D rendering.  
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Use Draw Mode Single Click by clicking the left mouse button in different 
locations of the 2D view of the structure model. The effects of editing (in 2D view) 

are observed as soon as the left mouse button is released. After editing (in 2D 
view), close the Paint Settings dialog and switch to 3D rendering. 
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Use Draw Mode Straight Line by clicking the left mouse button and drawing the 

line to the desired end point while holding the mouse button clicked.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The brush modes Set, Add, Subtract and Replace may be selected from the pull-
down menu Brush Mode. When using Set, Add, or Subtract, material intersections 

occur. In these areas, the Material ID of the intersection or the subtraction is given 
by adding or subtracting the binary numbers of the Material ID codes column-wise. 

In the following example, to better observe material intersections, the GeoDict built-
in red-green-yellow-blue color scheme is used.  

This color scheme is obtained by selecting Settings → Color & Visibility Settings… 

and clicking the icon at the bottom of the dialog (Load built-in default settings). 
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For this example, two slabs were created with 5x20x5 voxels each.  

 

In Set mode, the chosen Material ID completely fills the voxels, so that original 

materials are replaced. The replacement of material is clearly seen in 3D rendering:  

 

 

In Add mode, the selected Material ID does not fill the voxels, but an intersecting 
material is built.  

According to GeoDict’s rules on coloring intersecting materials (see below page 80), 
adding voxels of blue material to original red material results in violet-colored 

intersected voxels. Blue material added to original green material results in cyan-
colored intersected voxels. The intersecting materials are also seen above in 3D 
rendering. 
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In Subtract mode, the selected Material ID is bit-wise subtracted from the existing 
structure where the brush is applied (see below page 80).  

 



GeoDict Graphical User Interface – GUI Sidebar 

GeoDict2022 User Guide  79 

In Replace mode, the selected Material ID replaces the Replace ID, not selected 

Material IDs are unaffected by the modification. 
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INTERSECTING MATERIAL IDS FOR ADD AND SUBTRACT MODES 

With the GeoDict built-in color settings, 16 Material IDs are available. 

In Add and in Subtract edit mode, when two materials intersect or are subtracted, 
the Material ID of the intersection or the subtraction is given by adding or subtracting 

the binary codes corresponding to the Material IDs. 

 

 

 

 

 

 

The addition or subtraction of Material IDs is done column-wise, as follows: 

 

 

 

 

 

Examples of Material ID and binary codes of intersection materials obtained by 
adding: 

First material Second material Intersection material 

Material ID 
Binary 
code 

Material ID 
Binary 
code 

Material ID Binary Code 

 0010  0100  0010 + 0100 = 0110 

 0011  0100  0011 + 0100 = 0111 

 0011  0101  0011 + 0101 = 0111 

 0101  0001  0101 + 0001 = 0101 

Examples of Material ID and binary codes of intersection materials obtained by 
subtracting are: 

First material Second material Intersection material 

Material ID 
Binary 
code 

Material ID 
Binary 
code 

Material ID Binary code 

 0001  0001  0001 – 0001 = 0000 

 0101  0010  0101 - 0010 = 0101 

 0011  0001  0011 - 0001 = 0010 

 0100  0001  0100 – 0001 = 0100 

 

Binary addition rules  Binary subtraction rules 

1 + 1 = 1  1 - 1 = 0 

1 + 0 = 1  1 - 0 = 1 

0 + 1 = 1  0 - 1 = 0 

0 + 0 = 0  0 - 0 = 0 

0  0 0 1 
 

+   + + + + 

0    0 1 1 
 

=  = = = = 

0     0 1 1 
 

0 0 0 1  

- - - - - 

0 0 1 1  

= = = = = 

0 0 0 0  
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METROLOGY 

With the Metrology functionality, distances and angles can be measured in the 2D 
View of a structure.  

Select View → 2D Cross Section (SEM) in the menu bar.  

Click the Metrology tab on the GUI sidebar or click the icon  in the toolbar to open 
the Measure Angles and Distances dialog.  

In the Camera tab of the 

Visualization panel, choose the 
Direction (X, Y or Z) and the 

Slice of the structure for the 
measurement. 

 

To start a new measurement, 
first select from the New 

Measurement Settings if a 
Distance, an Angle or Angle 

and Distance should be 
measured. 

 

 

 

 

 

 

 

 

 

 

 

Next, in Snap to grid, define if 
points should be selected freely 

in the structure (Free 
Placement), or be snapped to 
the nearest voxel centers, 

voxel corners or edge centers. 

 

In the Visualization Settings, 
choose the Line Thickness 
and Color for the visualization 

of the measurement. 
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To start measuring, click with the left mouse button at the position, where the 

measurement should be started and draw the line to the desired end point.  

In the example shown here, the diameter of the red fiber in x-direction is measured. 

For the Active Measurement, the measured distance and/or measured angle is 
shown. 

Check Hide to hide the measurement and the text, or uncheck Show Distance, to 
hide only the text. 

With Delete Measurement, the measurement currently active is deleted from the 

panel. 

 

These options are especially helpful when several measurements are available in the 

panel. 

Create e.g., a second measurement, measuring the length of the gray fiber segment 
and its angle to the x-axis. 

Use the check boxes to show only one of the measurements or part of it. 

In case an angle is measured, the angle of the segment is shown counterclockwise, 

as long as Counterclockwise Angle is checked. 
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Clicking Adjust Voxel Length, a dialog to change the voxel length of the structure 

opens.  

Enter the desired length of the measured line (in the example 8.5 µm instead of the 

8 µm measured in Measurement 1) and click OK. The voxel length of the whole 
structure is rescaled to match the desired length. Check Rescale all volume fields, 
to rescale also the volume fields to the new voxel length. 

 

 

 

 

 

 

 

 

 

 

 

In the All Measurements part of the panel, all 

available measurements, can be hidden or deleted. 

 

 

 

Choose Lock Measurements in the Editing 

Settings part of the panel to move the whole line of 
a measured distance and/or angle to another location. 

If Lock Measurements is unchecked, the end point 
of the measurement can be modified. 



GeoDict 2022 Base Reference 

84  GeoDict2022 User Guide 

CONSOLE 

Starting with GeoDict 2020, the console window that used to appear when starting 
GeoDict has moved for convenience of usage to a panel located at the bottom of the 
GUI, under the Visualization area. The Console panel is a textual GUI window and 

log viewer. The console allows to read the system logs, help find certain ones, monitor 
them, and filter their contents. Additionally, the user can enter and execute python 

commands directly in the console (for more details, see the Automation 2022 
handbook of the User Guide).  

The console panel can be expanded and collapsed by clicking on the  and  icons. 

When expanded, the panel can be un-docked and turned into a dialog that can move 

around. Undocking is done by clicking the  icon, located left from the  icon after 

expanding. 

 

 

 

 

https://www.geodict.com/Support/UserGuide.php?lang=en
https://www.geodict.com/Support/UserGuide.php?lang=en
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